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CAUTION 

Read Instructions Carefully Before Use!  
 

• This device is a stress test ECG system intended to be used with a personal PC that complies with the EN60950 
standard. The device has the CE mark. 

• There are no side effects of the device  

• Treadmill comprises moving parts. Keep the children away while the moving parts are on  

• Device is to be used only by/or under supervision of dedicated medical personnel who have been trained 
specifically in the ECG Stress Technique and in the evaluation of ECG data under stress. 

• Make sure that ECG cable/electrodes and other parts of the system do not touch the surrounding conductors and 
ground in the environment. 

• Only use the ECG cable and USB cable provided by the manufacturer to guarantee safe operation during 
defibrillator use. 

• To avoid a possible explosion, do not use the electrocardiograph in the presence of flammable anesthetics 

• Check if the device is properly grounded, please ask authorized technician.  

• Do not use the device in dusty environment, please keep liquids and solvents away. Do not use solvents for 
cleaning this system and its accessories. Do not use high temperature or radiation sterilization techniques. 

• Check that all cable connections are safe and secured before use 

• The accuracy of the measurements made by the device is defined under normal and high quality signal acquisition 
conditions. If there are disturbances on the signals, the accuracy of the measurements can be affected. For such 
situations, the operator should interpret the signals using his/her experience on the view of the obtained ECG signals. 

• Check the integrity of the system and its parts every day before use. Let the authorized technician inspect the 
device at least once a year for maintenance and calibration. 

• This device is not suitable for direct cardiac applications. 

• Please comply with national and international regulations in use of disposable materials. 

• Proposed lifetime of the system and ECG card is 5 years. Manufacturing date is stated in the serial number, first 
part as XXYY shows the year of manufacture XX and the week of the year YY. Disposal of the device shall be made for 
each part separately by experts. 

• If you are unsure that device is functioning properly, please contact our technical service via phone number, fax or 
e-mail. If there is not any signal or only a straight line on one of the channels or any lead contact warning on the 
screen, the device is inoperable.  

• Device can be used safely in patients with pacemakers.  Make sure external pacemaker and stimulator connections 
are at a sufficient distance from ECG electrodes. In case of ambiguity, contact Kardinero. 

• Use only parts and accessories supplied with the device and available through Kardinero. (ECG patient cables order 
no:600322) The use of accessories other than those specified may result in degraded performance or unsafe use of 
this device.  

• Device is not intended for home use or patient self-use. 

• This device is not intended to be used in Operating Rooms (OR) or with high frequency surgical devices. If it must 
be used, then to prevent high frequency burns, keep ECG electrodes and cables away from the neutral electrode of 
the high frequency surgical device and also the operated area of the patient. 

• Kardinero has every right to modify software to improve product performance. For differences between this user 
manual and your software version, contact Kardinero or reseller. 

• This ECG device complies with EMC regulations. Details are given in Annex-C 

• Transportation of the device: Device must be transported by Kardinero or using the pallet and crating which are 
approved by Kardinero. 
Class I– CF Type Defibrillator Protected Medical Device  
Mains: 220V±10%/ 50Hz±5%/ 2500VA 
Operating / Storage Conditions 
Temperature: +5°C +45°C Humidity: 95% max. 
 
KARDİNERO A.Ş. 
Head Office:  
Üniversiteler Mah. I. Dogramaci Blv. No. 29 
ODTU Teknokent Gümüs Blok BK-7/B  
Cankaya Ankara 06800 Turkey   
     

http://www.kardinero.com.tr 
info@kardinero.com.tr 
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1. INTRODUCTION 
 
1.1. About Kardinero  

 
Since 1988, Kardiosis and its successor Kardinero are one of the world’s first PC based ECG manufacturers. 
With representatives across continents, Kardinero is striving to achieve a high customer satisfaction. Our 
R&D division is working to find solutions to the ever-changing demands of the medical sector. 
Thank you for choosing Kardiosis products. 
 
1.2. About User Manual  
 
This manual covers settings and installation for ECG Stress System and system configuration of its special 
software StressWin Pro, printer installation and settings, and troubleshooting some problems that may be 
encountered during system setup and usage. 

• When you encounter any problems, consult to the chapter titled ‘Maintenance and Repair’. 

• If you can’t troubleshoot the problem, call Kardinero Technical Service Department for help. 

• Information is provided for using StressWin Pro software in Chapter 7. You can use StressWin Pro 
efficiently by reading this chapter carefully. 

 
2. ABOUT ARS-EFOR ECG STRESS TEST SYSTEM WITH TREADMILL 
 

This system has been designed and manufactured for electrocardiography recording and reporting during 
exercise in order to use in diagnosing cardiac diseases on adults or children of suitable body size, according  
to the doctor’s decision. System must be used under the supervision of an authorized doctor. Patients, to 
be tested must be able walk on the treadmill. Before testing patients who may encounter difficulties while 
walking, it is advised to let them try it manually and slowly and get used to walk on the treadmill. With this 
manual prepared by Kardinero Inc., it is aimed to provide users with the basic information such as usage, 
simple maintenance, problems that may be encountered and solutions for them, and technical 
specifications. Consult our company for the subjects that are not covered in this manual. 
 
System is PC-based and consists of the following units: 

• Treadmill 

• ECG Module (ECG Master USB Module) 

• Main computer unit, monitor, keyboard, mouse 

• Patient cable with clamp end (EKG patient cable of Kardinero with defibrillator protection, suitable 
for ECG module used), 

• Connection and power cables 

• Clamp type defibrillator protected ECG patient cable  

• Software and documentation (StressWin PRO) package including software for system, operating 
system and driver software, documentation and manuals 

• System trolley 

• Automatic Blood Pressure Monitor (optional) 
 
If you have purchased ars-Efor as a kit only, you need to provide your own PC, printer and trolley. 
 
System must be setup by Kardinero Service personnel or others authorized by Kardinero. A simple setup 
diagram of the system is shown in user manual. System is delivered with software already installed by 
Kardinero during manufacturing. The user is responsible for any problems encountered because of the use 
of any other software unless permitted by Kardinero. 
 
Kardinero disclaims any responsibility for the problems that may occur due to the failures or conflicts 
during the installation of other software and/or hardware. 
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Software set shipped with the system is provided to use for servicing when needed later. Since all of them 
are licensed, it’s forbidden to install them on different computers. User will be responsible for violations 
on this subject. Setup and setting instructions provided in followed chapters are for general information. 
Under normal conditions it’s advised to carry out these settings by Kardinero authorized personnel. 
 

2.1. Introducing Stress System 
 
 

                   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 1. System Trolley (Console) 

 
Figure 2. Treadmill 
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2.1.1. Hardware Requirements 
 
PC 

• The microprocessor should have mid-to-top speed and processing capability. 

• The ECG Master must have at least one USB port for the USB device. 

• Master Memory (RAM) must be at least 8 GB. 

• On the motherboard, at least one RS 232 Serial Port connector must be provided for the treadmill 
control. 

• If an automatic blood pressure measuring device is to be found; 2 more RS232 outputs (for Tango+) 
or 1 RS232 and USB outputs (Tango M2) are required. 

• The hard drive must be at least 500 GB. Larger disk capacity is recommended. 

• Minimum 4 GB of display memory. The corresponding video card must support 1920x1080 and 
32Bit color resolution. 

• The monitor must support 1920x1080 or higher resolution. 

• Must be a PS / 2 or USB mouse. 

• DVD-RW is recommended for data recording and storage. 

 

ECG 

• ECG Master USB Module with 10 lead patient cable 

 

Printer 

• Laser printer: Minimum 600 dpi resolution for black and white prints 

 

Treadmill 

• TM-Pro Series 

• Optionally: 

- Suntech TANGO automatic blood pressure monitor, 

- Kardinero USB ECG compatible vacuum-electrode system, 

- Ergonomic bicycle, Ergoline compatible, 

- For computer hardware and accessories installations, you can refer to hardware units’ 
booklets. 

 

 

2.1.2. Software Requirements 
 

• Windows 7, 8 or 10 operating system, 

• StressWin Pro software installation program, 

• ECG Master USB Module device drivers (these drivers are automatically installed during StressWin 
Pro software installation), 

• Printer device driver, 

• Video card device driver, 

• Monitor device driver, 

• Optional: Resting ECG interpretation software, 

• Drivers for other hardware, software requirements are required. 
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2.2. SYSTEM PROPERTIES 
 
2.2.1. About StressWin Pro  
 
StressWin Pro is the software of ECG exercise test system for monitoring, recording, control and reporting 
of stress ECG. This software has been designed and developed completely by software programming staff 
of Kardinero R&D Department. 
StressWin Pro, 12-lead ECG Stress Test software, is real-time and compatible with Windows 7/8/10; and 
has following properties: 
 

• Receive real-time ECG data, 
• Display of ECG signals on the monitor (6x2, 3x4, 12, 6, 3, 1, Average), 
• Recording of ECG signals, 
• Detection of QRS complexes and averaging of signals, 
• Receiving reports from the printer after rest, exercise, relaxation and testing, 
• Reports during rest (pre-test: pre-test), 
• Reports during testing (in Exercise and Relaxation), 
• Averages and 12 channel Records (Raw Data – RawData), 
• Averages and 12 channels Linked Median, 
• Post-test (recovery) reports, 
• Slope, ST, ST-Heart Rate Trend Charts, 
• Summary page (Blood Pressure, Pulse Graph), 
• Event recording output, 
• Review output (Doctor’s reviews), 
• Saving the entire report in JPEG format, 
• Saving the entire report as a complete PDF file, 
• Saving report pages in JPEG format, 
• Dicom integration, 
• Health institution and patient information output, 
• Frozen 10 second ECG recording output, 
• Automatic control of treadmill slope and speed by the software, 
• Control and monitoring of the applied values (speed, slope) for the treadmill  
• Optional ergometer bicycle power control (Watts) and  monitoring  of the value, 
• Protocol selection (Bruce, Naughton, Ergo etc.) and protocol creation as desired, 
• Amplitude and speed indicators for the ST measuring point, display and outputs, 
• Filter application possibilities, 
• 50 Hz or 60 Hz line filter, 
• EMG filter, 
• Baseline filter, 
• Freeze and review of 10 seconds of ECG signals features. 
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2.2.2. Technical Specifications 
 
Standard Exercise ECG Testing  
- MS Windows based exercise ECG testing 
software: StressWinPro 12 channel real time 
simultaneous ECG monitoring 
-Automatic control of Treadmill with the 
software 
-Bruce, Naughton and many other protocols with 
possibility of adding unlimited user defined 
protocols. 
-Also suitable for ‘Ergometric Bicycle’ 
-Real time continuous ST level and slope trends  
-Real time ECG averaging and displaying  
-Average (average) calculation and 
representation of ECG signals in real time 
-Blood Pressure and Pulse Trend Charts 
-Target and maximum target pulse values 
-Heart Rate  
-METS display  
-Freezing of screen and print-outs of frozen 
sections. 
-Selectable Full Disclosure ECG recording 
-Step forward-backward during testing 
-Manual treadmill control during stress testing  
-Display of step related information 
-Full disclosure storage of ECG data on  
-Audible warning before step changes for the 
patient and the clinician 
-1000 patient records require approximately 15 
GB disk space. 
  
Reports 
-User selectable report options 
-Drawing options for averaged and raw data 
signals 
-ST-level trend with point-J 
-Reports of averages and ECG signals  
-ST level/slope values at each step 
-ST level/slope, heart rate and blood pressure 
trends 
-Patient data  
-Doctor’s remarks 
-Event reports 
-Print outs of frozen screen sections 
 
ECG Signal  
-12 channel recording 
-Derivations: Standard: DI, DII, DIII, aVR, aVL, aVF, 
V1-V6 
-Maximum sampling rate for signal processing: 
4000 sps per channel 
-Frequency response: 0.05 – 300 Hz (3dB) 
-Time constant: 3.2 s (min) 

 -CMRR: 120 dB  

-Sampling resolution: 0.3 V ( 2 bit) at 16 bits 
sampling 
-Defibrillator protected patient cable and input 
circuitry 
-Software digital filtering: EMG, baseline and line 
filters 
-Amplitude scale (screen and print-outs) 2.5, 
5,10,20,40 mm/mv 
-Time scale (screen and print-outs) 
12.5,25,50,100 mm/sec 
-Design and production comply with EN60601-1 
(IEC 601-1) Electrical Safety Standards. 
 
Treadmill 
-Automatic speed and slope control 

-Speed: 0- 17.0 km/h (0.1) (Optional: 25   km/h) 

-Slope: 0-25 % (0.1) 
-Internal dimensions: 55 cm x150 cm 
-External dimensions: 70.5 X 209 x 132 
-Load capacity: 180 kg 
-Safety: Emergency stop button 
-Speed motor power: 2.2 kW 
 
Control Unit 
-Minimum Pentium IV based PC  

-Windows XP operating system 
-System trolley 
-Laser printer 
-Modem interface 
-21” color monitor 
 
Optional 
-Automatic dynamic blood pressure monitor 
-Ergometric Bicycle 
-Uninterruptible power supply (UPS) 
-Vacuum electrode system 
 
NOTE: Tolerances for the measured parameters 
above are 5%, which corresponds to hardware’s 
amplitude and time scale accuracy. High noise on 
the acquired signals may affect the calculations 
performed by the SW, and may result to exceed 
these tolerances. Heart Rate calculation 
performed during exercise is sensitive to some 
parameters and the tolerance margin for heart 
rate is 10%. 
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3. Installing StressWinPro Software 
 

WARNING: Connect ECG Master USB Module after installation 
 
3.1. Installation 
 
Insert the StressWinPro installation CD in the CD/DVD driver. Installation will start automatically. 
Or; copy the “StressWinPro_Install….” File to your computer and run it. 
 

*Note: If CD/DVD driver has not been set to automatic execution mode, installation will not start 
automatically. In this case, open the files in the CD, then find and click the “Setup.exe” file for installation. 

  

IMPORTANT: The StressWin PRO program requires Microsoft’s .NET (dot net) framework to work. The 
StressWin PRO program checks whether the .NET Framework is installed on your computer during 
installation. If the program is not installed, install the .NET Framework program named .exe dotnetfx.exe 
.NET on the installation CD. Or; visit Microsoft support web site for installation of actual .NET Framework. If 
you are experiencing a .NET Framework problem with older versions of Windows, contact your computer 
service support or Kardinero. 

 

Then, you will see the ‘’StressWin Pro Installation’’ window below. Click ‘Next >’ (Figure 3) 

 

 

 

Figure 3. StressWin Pro Installation Opening Window 
 
After pressing the “Next” button, the “Setup Wizard” box shown below will appear. Click “Next >” to continue 
the installation. (Figure 4) 
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Figure 4. StressWin Pro Setup Wizard Window 
 

You will then be asked which directory (folder) you want the program to install. The default value for this 
directory is C:\Program Files\Kardinero\StressWinPro\. You can change the name of this directory or you can 
accept the default value. “Just Me” select the option if you are going to use the program and select 
“Everyone” if it is to be used by other users. Press ‘Next >’ after you have finished. (Figure 5) 
 

 

 
 

Figure 5. Select Installation Folder Window 
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The appearing window indicates that the setup wizard is ready to install the StresWin Pro software on the 
computer. Click “Next >” to start the installation. (Figure 6) 
 

 
 

Figure 6. Confirm Installation Window 
 
During the installation, the screen you received at this stage is the approval of the license agreement. The 
system software may only be installed and used by licensed users who have purchased the software and or 
hardware. 
 
Read this license text and if you feel that you do not agree with the terms you do not agree with, select “I Do 
Not Agree” and click Cancel to cancel the installation. Contact your authorized dealer. If you agree, click “I 
Agree” and click “Next >” to proceed. (Figure 7) 
 

 
 

Figure 7. License Agreement Confirmation Window 
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After this step, the installation of the Stress Win Pro program and copying the files of the program to the 
computer is in progress. Please wait until copying is complete. (Figure 8) 
 

 
 

Figure 8. Installation Progress Window 
 
Press the Close button to complete the installation process with the window below. (Figure 9) 
 

 
 

Figure 9. Installation Completion Window 
 
Important: Keep your installation CD/ or files in another platform in a safe and convenient place, 
considering that you may need it in the future. 
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3.1.1. Uninstalling StressWin Pro 
 

You can uninstall StressWin Pro in two ways. As shown in Figure 10, first option is to use the installation CD 
itself. Select “Remove StressWin Pro” button and then click “Finish” button.  

Second option is to use “Start – Control Panel – Add or Remove programs”. Select “StressWinPro” and then 
click “Remove” button. 

 

 

 

Figure 10 

 

3.2. Installing ECG Master USB Device 
 
The installation of your ECG Master USB device is done directly by other means such as well-known USB-
connected devices. Depending on the computer you are using, the USB port connection may be on the rear, 
front, or side of the computer chassis. There may be more than one USB port on desktop computers. You can 
easily identify a USB port by looking at your device’s USB connection cable. 
If you are using more than one USB connected device, you can also use a standard USB hub for connection. In 
this case, insert the USB cable of your ECG in the same way as in the socket. 
If you are not familiar with the USB connection, follow the instructions for your computer’s user manual. You 
can also call the service for help. 
 
It is important to have the power connections and grounding of your computer properly to get a good ECG 
signal. If you have problems with grounding, ask an experienced electrician for help. 

Important: Your ECG Master USB device does not need to stay connected to your computer always. When 
you want to use your device, you can connect your USB cable to your computer. The point is that you should 
run the software after connecting the device to the computer. 

The green LED on the ECG Master device is the indicator that your USB device is working and is shown in 
Figure 11. This green LED flashes once when you connect your device to your computer. When you run the 
program, the LED is lit continuously. When you exit the program, the LED goes off. 
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Figure 11. EKG Master USB Module 
 
After the ECG Master USB Module is installed, and when the Module is connected to the computer, the device 
is shown under Control Panel > Device Manager under Universal Serial Bus Controllers (USB) displayed as the 
Kardinero ECG Master USB or TEPA USB DEVICE. (Figure 12) 

 

 

 

Figure 12. System Recognition of ECG Master USB Module 
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3.3. Entering Module Password 
 
After the installing the software (see 3.1.), please run the program once to enter ECG USB Module password. 
This will open the entry screen. (see Figure 13) 
 

 
 

Figure 13. USB Key Window 
 
 
After the USB Key Window opens, enter the password given to you by the Kardinero Authority as shown (see 
Figure 14). 
 
NOTE: Be careful for upper case and lower case when entering the password! 
 

 
 

Figure 14. USB Key Window 
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4. INSTALLATION OF STRESS TEST SYSTEM 
 

4.1. Mechanical Setup 
 
Treadmill must be located on a pure and plain horizontal surface having zero slope. Trolley must be placed 
somewhere near the treadmill. Thus, the patient cable and data cable are guaranteed to be in appropriate 
distance. These cables should not be squeezed and damaged because of the movement of the treadmill. 
 

4.2. Electrical Setup (ECG Master USB) 
 

USB and patient cable must be laid with precaution to avoid them getting squeezed and damaged under the 
treadmill. The treadmill must be connected to an outlet with protective ground, as indicated in Figure 15. EKG 
Master USB module has to be connected to a USB port of the PC and patient cable should be connected to the 
ECG module. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 15. Patient, ECG Master USB and Treadmill Electrical Connections 
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4.3. SunTech TANGO Dynamic Blood Pressure Monitor Setup 
 
Suntech Tango automatic blood pressure device, which works in real time with the ECG Stress Test system, has 
two different models, Tango Plus and Tango M2. There are differences between these 2 different models’ 
computer setups. Follow the appropriate Suntech Tango computer installation information from the following 
Suntech Tango computer installation information. 

For the Suntech Tango M2 automatic blood pressure device to be included in the exercise system, the 
computer is installed as follows: 

If you want to monitor blood pressure automatically during exercise, you should add your Suntech Tango M2 
Model dynamic blood pressure monitor to our system. Note: The two sided 9-PIN RS232 cable used in the 
previous model has been replaced. The replaced connection will be made via a USB A-B cable. Hardware 
installations must be started first. The Tango M2 Patient ECG trigger cable’s (green cable) BNC end is plugged 
into the device and the relevant RS-232 Port of the computer appropriately. USB A-B cable’s device part 
should be connected to the matching socket on the Tango M2 and the other side should be connected to the 
one of  the PC’s USB ports. Please copy the required Driver File to the desktop for installation. Click on Control 
Panel and open Device Manager. In Device Manager, there will be a connection in the Ports section to the 
TANGO M2 Serial Over USB Connection (COM ...). Right-click on the TANGO M2 Serial Over USB Connection 
and select Update My Computer in the window that appears after you click “Scan My Computer” for Driver 
Software. Click on the window in the new window that opens, select the file on the desktop we have given for 
installation, click Next and then click Close. To check at the end of the installation, see the Tango M2 Serial 
Over USB (COM ...) connection in Device Manager. Open the settings in the StressWin Pro program. (Figure 17) 
On the Devices tab, select the Port selection (COM ...) in the Blood Pressure as you set Tango M2 in the Device 
manager. For the ECG Trigger, select the PC’s port number, as you connected ECG trigger cable to the RS 232 
port. This is necessary to receive the ECG-R wave synchronization signals from the system. Finally, set up your 
settings as shown in Figure 16 from the Monitor Setup on your TANGO M2 automatic blood pressure monitor. 
After these selections, the installation is completed and ready for processing. If necessary, these settings can 
be changed in Settings. All of these settings will be made at the initial installation of the system. Contact 
Kardinero if you have a problem with the setting and communication ports. 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

Finally, set your settings as shown in Figure 16 in the Monitor Setup on your TANGO M2 automatic blood 
pressure device. 

 

 

 

Figure 16. Suntech Tango Main Menu Setup 
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Another model is Tango Plus and its installation on the computer for inclusion in the exercise system: 

You need to add the Suntech Tango Plus model dynamic blood pressure monitor to your system. The monitor 
needs three serial ports that are open on the computer in your exercise system. Desktop computers are 
usually available in two and the third port is used for serial port multiplexer. In the Port section of the Blood 
pressure section of Figure 17, the COM port should be selected in the Port section where the standard RS-232 
serial port cable is connected to provide communication between the dynamic blood pressure monitor and 
the computer, and to receive the ECG-R wave synchronization signals from the system in the ECG timing port, 
the COM port with which the used cable is connected must be selected. A cable ECG synchronization cable 
with one end BNC connector and the other end with 9-PIN RS-232. If necessary, these settings can be changed 
in Settings. All of these settings will be made at the initial installation of the system.  

Contact Kardinero if you have a problem with communication ports. 

 

 

 

Figure 17. Setup Screen 
 

On the SunTech side, protocol should be selected as SunTech and ECG Trigger as Digital↑ (Digital up).     

 

* NOTE: Since the previous TANGO Plus model does not have a USB connection, a two-sided RS-232 cable 
will be used; its connection is described above. 

 

5. Printer Installation 
 
In some printers, the installation programs in their installation CDs automatically detect and install the 
software as soon as you insert the CD. If you have a printer connected to your computer via a USB port, the 
Windows operating system usually installs the driver software for this printer on your computer 
automatically. If it cannot perform the installation in full, he will ask you to insert the CD of that printer into 
the drive. 
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One way to install a printer is to enter it in Start-> Printers and Faxes; Click Add Printer. In this case, the 
computer will ask you questions about the location and installation information of the printer you want to 
install. You may also need to use the installation CD or diskette that came with your printer. If you have any 
difficulty, please consult your computer specialist.  
 
6. SETTINGS 
 
Settings discussed in this chapter have to be adjusted by Kardinero’s authorized personnel during first setup. 
The instructions below are provided as general information. In case of a need for re-adjustment, especially 
because of changing location, carrying out these instructions by experienced staff that has the knowledge of 
computer hardware and software is favorable. If you encounter setup problems related to your system, apply 
Kardinero Inc. authorized service personnel. 
 
6.1 Treadmill Settings 
 
6.1.1. Treadmill Foot Settings 
 
Treadmill includes 4 feet: 2 front wheels and 2 rear-setting feet. When the treadmill is set to run, if there is 
vibration/oscillation, this can be corrected by rotating rear setting feet in “E” and/or “G” directions to level the 
treadmill on uneven surfaces. (Figure 18) 
 

 

 

 

 

 

 

 

 

 
6.1.2. Treadmill Band Settings 
 
Band setting is the adjustment that must be done when the band slips to the sides. During the adjustment, 
adjusting screw is squeezed in A-B-C-D directions while the band’s speed is at 3 km/h and tension is kept 
constant. If Band slipped to the right, screw is squeezed in A or B direction while being sure not to change the 
band’s tension. If Band slipped to the left, screw is squeezed in C or D direction while being sure not to change 
the band’s tension, see Figure 19. 
 

 

 

 

 

 

 

 

 

 

 

Figure 18. Treadmill Foot Settings 

Figure 19. Treadmill Band Settings 
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6.2. Screen and Display Settings 
 
We recommend StressWin Pro software to be used on 1920 x 1080 (HD) screen resolution. Display properties 
are needed to be adjusted accordingly. To do this, right-click a blank spot on the Desktop and select “Screen 
Resolution” from the shortcut menu. You’ll see the dialog box related to display settings shown Figure 20 
below. Adjust the resolution to 1920 x 1080 pixels.  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
6.3. Setting the Program Language 
 

StressWin Pro program language can be set by changing the language of the Windows. To do this, use Start -> 
Control Panel -> Date, Time, Language and Regional Options -> Regional and Language Options and select 
the language of your choice from the list as shown in Figure 6.4. If selected language is not supported by 
StressWin Pro, English will be used as default.  

 

IMPORTANT: If your operating system is in English and the program is running in 
English, make sure that the language option in the taskbar is in English. If you are not in 

Turkish, click on it to try Turkish (TR). If such an option does not appear; For the region; Start -> Settings -> 
Control Panel -> Regional portion of Turkey (Figure 21) by selecting, for Languages; You can select English 
(Figure 21) in Start -> Settings -> Control Panel -> Language Options. During this process, Windows may 
prompt you to install the Microsoft Windows installation CD. If you are having problems with this selection, 
contact your computer provider or Kardinero. 

 

 

 

Figure 20. Screen and Display Settings 
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Figure 21. Regional and Language Settings 
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7. USING STRESSWIN PRO 
 

This chapter gives the instructions for using Kardinero Stress Test system. Turn on the power to the treadmill 
and the computer. Treadmill On/Off button is located at the rear of the treadmill.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ECG Electrodes’ Layout 

 

R (RA)  Red  Right arm 

L (LA)  Yellow  Left arm 

F (LL)  Green  Left leg 

N (RL)  Black  Right leg 

C1  Red  Intercostal gap at the right of sternum 

C2  Yellow  intercostal gap at the left of sternum 

C3  Green  At the mid-level of C2 and C4, on 5th costal bone 

C4  Brown  Mid-front armpit line of left collar bone 

C5  Black  Left-front collar bone line on C4 horizontal level 

C6  Purple  Left-mid collar bone line on C4 horizontal level 

 

After system is ready to use, cables are placed on patient’s body (Figure 22) and the patient is prepared for the 
test. Patient and system must be prepared by personnel experienced in ECG stress test. You must be sure that 
electrodes are attached firmly, electrodes and ends of patient cables attached to electrodes are fixed by net 
bandage and they do not move during the test. Please use high quality electrodes which are suitable and 
recommended for ECG stress testing. Make sure that ECG cable/electrodes and other parts of the system do 
not touch the surrounding conductors and ground in the environment. 
 
 

 
 

Figure 22. ECG Electrodes Layout 
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Electrode layout configuration used is standard 12 leads (6 extremity, 6 chest). 10-lead patient cable 
connection points to acquire standard 12 derivations are shown in Fig. 22. Patient must walk on treadmill with 
comfortable socks and must not use shoes. This is required to avoid static electricity due to different shoe 
types.  
To start the program, follow the menu commands “Start -> All Programs -> StressWinPro”. You may also start 
the program by clicking/double clicking the StressWinPro shortcut icon on the Desktop. 
   

7.1. Startup Screen 
 

Using the toolbar buttons, Startup Screen enables you to start a new test, open an existing test, change 
settings and access program info, as shown in Figure 23. You can also reprint previous tests using the 
“Reprints” menu item under the “file” tab. 
 

 

 

Figure 23. StressWinPro Startup Screen 
 

Menu Bar: As indicated on Figure 23, all program functions can be accessed using the mouse or keyboard. To 
access menu items via keyboard, first press “Alt” key and then use arrow keys to select the menu item. 
Shortcut keys for some menu items are also available using function keys “F1, F2, etc.” 
 
Tool Bar: Buttons and combo boxes are placed on the toolbar. Frequently used menu items have their 
corresponding buttons. Use mouse to select desired button functions. 
 
Status Bar: Lower most bars on the screen. Status messages and other information are displayed on this bar. 

 

New 

Open 

Setup 

About 
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Heart Rate Calculation: 

 

 
 
 
 
7.2 How to perform a test? 
 
Before explaining all functions in detail, it’s useful to discuss, in general terms, how to perform a stress test 
and the steps it includes. During stress testing, a patient is allowed to run on a treadmill. Stress test consists of 
three steps: Rest, Exercise and Recovery. As it can be understood from their names easily, rest ECG recording 
is done while patient is inactive, or resting. This recording forms a reference for the signal base at later stages 
of the test. Therefore, it is recommended to do this recording while the patient is standing. During exercise 
recording, patient runs on the treadmill according to a particular protocol until patient’s heart rate reaches to 
a predefined target heart rate. Alternatively, maximum heart rate can be used, if desired. Choosing between 
“target heart rate” and “maximum heart rate” is found at “Setup->General” tab page. According to the heart 
rate chosen by the user, the GUI on the right updates the chart and the selected heart rate is written in bold 
characters. Patient may have difficulties with running on the treadmill or suffer from some health conditions 
during this process. In such a case, test must be finished and patient’s complaints must be recorded. After 
peak exercise step, patient enters rest (or recovery) stage and ECG signals are recorded. This last step is the 
recovery phase. ECG signals recorded during all phases are then assessed by the doctor. 
 
Throughout the following sections, stress testing is explained in detail. 
 
 
 

Karvonen formula: 
Maximum number of heart beats – % intensity of Rested heart rate + Number of  
resting heart rate 

Figure 24. StressWinPro Test Screen 

Moving Bar 

ECG Leads 



 

Copyright © Kardinero Inc., May 2021  Page 26 

 

7.3 StressWin Pro Commands and Functions 
 
Commands and functions accessible through the toolbar buttons are shown in Figure 25. 
 

 
 

 
 
 
 
7.3.1. New Patient Recording (NEW)    

 

You can start a new test by clicking on the “New” button on the toolbar or “File -> New” menu item on the 
menu bar. A dialog box to enter patient data is displayed in Figure 26. 
 

 

 

Figure 26. Patient Information Window 
 
At least one of the fields for ID, last name or first name must be entered. You may also skip entering data at 
this stage since same window will appear later in rest ECG approval stage. 
 
You are now ready to start the test. 

 

 

 

 

 

Figure 25. Toolbar 
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7.3.2. Start/Stop Recording 
 
Rest ECG recording will start at this stage with a default recording duration of 10 seconds. Recording duration 
can be changed from the “Setup” menu as desired. Before clicking this button make sure ECG signal quality is 
acceptable at all leads. You may wish to momentarily disable all filters at this stage to monitor the raw signal 
quality.  
After recording is completed, a rest ECG approval window is displayed. Averages and program calculated 
critical points (Q onset and J points) are displayed on the right. At this stage, you may change the position of 
critical points by moving the associated bars with the mouse as shown in Figure 27. 
If you are not satisfied with the recording, click on “Reject” else click on “Accept” button to proceed with the 
test. Then, patient information window will appear to give you a chance for entering or modifying patient 
data. You will not be able to modify or edit patient information after this stage.  

 

  
 

 

 

7.3.3. Replay    
 
 
 
 
 
 
 
 
 
 

Adjustement Bars 

Figure 27. Rest ECG Approval Window 

Figure 28. Replay Menu Item Figure 29. Replay Menu Item after Rest ECG is 
recorded 
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This feature enables the user to open ECG data saved in “scp” format for either rest ECG or stress ECG testing. 
At the start of ECG test, i.e. rest ECG testing, only the “Rest ECG” option is active, please see Figure 28. The 
user is allowed to select a “scp” file for rest ECG. After ECG data recording is completed, user is allowed to 
select another “scp” file to run for stress ECG testing, Figure 29. Therefore, “Stress ECG” option becomes 
active while the user is not allowed to click on “Rest ECG”.  For both cases, a dialog box opens for the user to 
select the ECG data file. The software runs the selected file as if a patient is connected to the device if the 
selected file is valid. 
 

7.3.4. Start Stress ECG Recording 
 
This control becomes active only after rest ECG recording is done and approved. When clicked, Treadmill will 
start running according to the selected protocol in the “Setup” menu. During stress testing, ECG averages are 
formed in real time and test parameters are calculated using the averages.  
 

7.3.5. Recovery Step  
 

When target heart rate (or maximum heart rate, depending on the configuration) is achieved or patient 
cannot exercise anymore or test is deemed to be sufficient, click on this control to skip to recovery steps of the 
protocol. If this control is not clicked, recovery steps will be entered after all exercise steps are finished as 
defined in the protocol. 

 

 7.3.6. Stop Stress ECG Testing  
 

Although test will be terminated automatically at the end of the protocol, it is possible to stop the test by this 
control before all the previous steps of the protocol are done. This control can be clicked at any step of the 
executed protocol. When clicked ECG recording is stopped and end of test reports are printed.  A remarks 
window pops up to allow doctor to write final remarks and a report. 
When the test is terminated, Startup screen appears again for a new test. 
 

 7.3.7. Step Forward 
 
This control enables you to skip the current step and proceed to the next step. 
 

7.3.8. Manual Control          
 
This command is used to intervene when the treadmill is deemed necessary during effort extraction. Clicking 
the button in the Figure 30 when this window is opened, the slope of the runner remains there and the speed 
is 0.0 (zero). The required speed and slope information can be sent here. During these operations, the 
patient’s signals are displayed, but the effort does not continue. When the window is closed, the exercise 
continues from where it left off (including Speed and Slope). 
 

 
 

Figure 30 
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7.3.9. Step Backward  
  

This control enables you to skip the current step and return back to the previous step. This function is disabled 
during the recovery phase in order to prevent any dangerous situations for the patient by going back to the 
stress phase. 

 

 7.3.10. Views  
 
Different ECG view formats are available to suit user’s preferences as shown in Figure 31. 
 
 
 
 
 
 
 
 
 
 
 
 
6x2    : Channels are organized as six rows by two columns. A rhythm channel selectable by the “Setup” 
menu is displayed at the very bottom of the screen. 
3x4 : Channels are organized as three rows by four columns. A rhythm channel selectable by the “Setup” 
menu is displayed at the very bottom of the screen. 
12 : All twelve channels are displayed one after the other as twelve rows.  
6 : Six channels selectable by the “Setup” menu are displayed as rows.  
3 : Three channels selectable by the “Setup” menu are displayed as rows.  
1 : One channel selectable by “Setup -> Leads -> Strip Lead” is displayed. 
 
 
7.3.11. Freeze 
  
This control freezes the last 10 seconds of ECG signals and displays it as shown in Figure 32. Frozen section is 

displayed in a separate window while real time ECG is continued to be displayed. You can save ( ), print (

) or automatically interpret ( ) the frozen ECG signal. 
 
 

Figure 31 
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Figure 32. Freezing the ECG signals 
 
 
 
 
 
 
 
 
7.3.12. Quick Print (WIP)  

 

This function is not fully developed yet, as of this version, and it is a work in progress. It is aimed to work 
similar to “Freeze” function, which is explained in Section 7.3.11, but providing the user with a print-out of the 
last 10 seconds of ECG data, instead of displaying it on screen. 

 

7.3.13. Patient Info        
 

 
Patient information can be viewed or edited by this control. At least one of the fields for ID, last name or first 
name must be entered before rest ECG is approved. You cannot change any of these 3 fields during testing 
since these fields are combined to form the folder name where test results are stored. 
 
 

7.3.14. Remarks          
 
Doctor’s remarks can be entered using this function. 
 
 

10 seconds of frozen ECG is  
displayed on the right 

ECG is continued to be  
displayed on the left 
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7.3.15. Event Record      
 
When this control is activated, an event record window pops up as shown in Figure 33. You can enter various 
data related to the event observed such as free text, blood pressure, etc. A snapshot ECG is automatically 
saved at the time when the control is first clicked and printed if print-out of events is selected at the “Setup” 
menu. 
 

 

Figure 33. Evet Record Window 
 
7.3.16. Blood Pressure 
 

Blood pressure window is displayed when this control is clicked. If you have a SunTech Blood Pressure Monitor 
connected to your system, you can initiate a measurement from this window and results would be 
automatically entered by the system. If you measured the Blood Pressure manually, enter Systolic and 
Diastolic values in mm Hg units in the appropriate data entry boxes, shown in Figure 34. Once you have 
completed the blood pressure data entry and clicked “Ok”, trend graphics will also be updated. 

 

 

Figure 34. Blood Pressure Window 
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7.3.17. Line Filter  
 

This control applies 50Hz or 60Hz line filter on the ECG signal. Use “Setup” to select 50 or 60Hz option. Since 
filtering masks the quality of raw ECG signal, it is always a good idea to momentarily disable filters and check 
the quality of the unfiltered ECG signal. 
 

 

7.3.18. EMG Filter   
 
If there is excess noise due to muscle tremor, use this control to apply EMG filtering on the ECG signal.  
 
 

7.3.19. Baseline Filter 
 

This control activates baseline filtering on the ECG signal. Note that baseline filtering delays the ECG signal 
about 3 seconds. 

 

7.3.20. Time Scale 
 
Speed at which ECG are displayed can be changed by selecting different time scales such as 12.5, 25, 50 or 100 
mm/sec. Use the time scale combo box or the related menu item to change ECG time scale. (Figure 35) 

 

Figure 35. Changing the time scale 
 
7.3.21. Amplitude Scale 
 
Amplitude scale at which ECG signals are displayed can be changed by selecting different amplitude scales 
such as 2.5, 5, 10, 20 or 40 mm/mV. Use the amplitude scale combo box or the related menu item to change 
ECG amplitude scale. (Figure 36) 
 

 
Figure 36. Changing the amplitude scale 
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7.3.22. Trends Graphics 
 

By using the right bar combo selection control, you can view ST level and slope trends on the right bar instead 
of averages. (Figure 37) 

 

 

 

Figure 37. Changing the trends graphics 
 
 
7.3.23 Enable/Disable Prints      
 
This button enables or disables printing of the selected print-outs depending on the number of clicks. 
 

 

7.3.24. Setup 
 

Setup enables you to change various user selectable parameters through window shown in Figure 38. 
 
If you open the Setup window during the test mode, some parameters may be locked to prevent changes. In 
this case open the Setup window on the Startup screen to access all parameters. 
 
In the following section, Setup tab pages will be explained in detail. 
 
7.3.24.1. General Tab Page 
 
The General tab is shown in Figure 38. 
 

 
 

Figure 38.Setup Window General Tab Page 
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QRS Detection Lead:  Auto QRS detection by default is done by majority voting on all channels. If the QRS is 
detected in more than half of the channels, then QRS is said to be detected.  It is also possible to select QRS 
detection on a single channel. 
 
Rest Record Time: Indicates the duration of rest ECG recording at the start of stress test. Default value is 10 
seconds. 
 
ST reference point: ST level is calculated at a selected distance after the J point. This reference point is 
adjustable between 10 – 80 ms. 
 
QRS Sound: When a heartbeat is detected it is indicated by a beep sound which can be turned on or off using 
this option 
 
Full Disclosure: All the raw ECG data during testing is recorded and saved if this option is enabled. Due to 
demand for hard disk and RAM memory space, this option is by default disabled. 
 
Arrhythmia Analysis: Basic arrhythmia statements are indicated on the status bar when this option is enabled. 
 
Display Signal Quality: The signal qualities of the channels are indicated on the status bar if selected. The 
channels with noisy signals are displayed in red color while the others are shown in green. 
 
 
 
 
Slow Speed Up: It allows the user to speed up the treadmill iteratively if needed. This functionality is generally 
requested by the users that have difficulties to run on the treadmill. 
 
Weight/Height: Metric or British imperial metric units can be selected. 
 

Default:    This button is used to set all of the above values to default values. 
Dicom Integration: To get information from the Dicom tab, it must be activated. The purpose of this structure 
is to access the structure where the patient information is stored and stored and the file containing the data 
from the patients is saved and stored. 

 

7.3.24.2. View Tab Page 
 

The View tab is shown in Figure 39. 
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Figure 39. View Tab Page 
 

Monitor Size: When monitor size is entered correctly, ECG amplitude and time scales on the screen will also 
be reflected more accurately, similar to an ECG on paper. Note that this adjustment is not related to ECG 
signals on printouts. 
  
Amplitude Scale: 2.5, 5, 10, 20 or 40 mm/mV values can be selected.  
 
Time Scale: 12.5, 25, 50 and 100 mm/sec values can be selected. 
 
Filters: Line filter eliminates 50Hz or 60Hz interference from power line voltage. EMG filter eliminates 
interference due to muscle tremor. Baseline filter eliminates baseline shift on the signal due to patient and 
electrode movements. In a good recording none of these filters would be necessary. 
 
ECG Colors: Colors related to displaying ECG signals such as background, trace, text and grid colors can be 
changed according to the user’s preferences.  
 
Wide Screen: Amplitude and scale of the ECG signal displayed on the screen are adjusted to a more 
approximate view when this option is selected. 
 
View grid: Milimetric grid is superimposed on the ECG signal when this option is enabled. 
 
View border: Border is superimposed on the ECG signal when this option is enabled. 
 
Enter patient data before recording: if this option is enabled, a patient information window is displayed to 
enter the patient data when a new test is started.  
 
Superimpose rest averages on screen: In rest ECG test, software calculates the average beats for each channel 
and stores them as a reference for stress ECG testing. If this option is selected, the average beats calculated 
for stress ECG and the rest ECG tests are drawn on top of each other. 
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Default:    This button is used to set all of the above values to default values. 
 

7.3.24.3. User Tab Page 
 

 

 

Figure 40. User Tab Page 
 
This setup page enables you to enter information about the user. This information is printed on the cover page 
of the report. Here you can also change the location of data folder where the test results are saved. (Fig. 40) 
 
7.3.24.4. Leads Tab Page 
 

 
 

Figure 41. Leads Tab Page 
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You can select channels of your choice to be displayed in the view formats of 6x2 and 3x4 by using the page in 
Figure 41. You can also select the desired strip lead to be displayed at the bottom of the display in these view 
formats.  

 

7.3.24.5. Devices Tab Page 
 
The Devices tab is shown in Figure 42. 
 
 

 

Figure 42. Devices Tab Page 
 

Acquisition Device: You can also use StressWin Pro in demonstration mode without the ECG device. ECG data 
in “demo.scp” file is displayed as if data is acquired by the ECG device. You can also run your own selected 
SCP-ECG files in demo mode. For this, just rename your file as “demo.scp”.  
 
Blood Pressure: SunTech dynamic blood pressure monitor adjustments can be done here. Refer to Section 4.3 
for details.  
 
Treadmill: You can select the RS232 port connection to treadmill, treadmill type and protocol to be used 
during the test. 
 
Protocol Editor: There are a number of protocols that comes with the StressWin Pro. You may also create new 
protocols or modify the existing protocols using the protocol editor or select any of the protocols as the 
default protocol. Protocol Editor is easy to use and self-explanatory as shown in Figure 43. 
 
Important Note: It should be noted that created protocols must be saved with “_ptc.xml” at the end of their 
name, using “.xml” extension alone is not enough, otherwise you might end up with a corrupt data file or no 
file at all. 
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Figure 43. Protocol Editor 
 
 

7.3.24.6. Prints Tab Page 
 

 
 

Figure 44. Prints Tab Page 
 

This part of setup enables you to configure print-outs related options. (Figure 44) 
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Printer Scale Settings: If “Same as screen” is selected, print-outs will have the same time and amplitude scale 
settings as set on the screen. You can also select fixed time and amplitude scale settings regardless of the 
screen settings. 
  
Printer Filter Settings: If “Same as screen” is selected, print-outs will have the same filter settings as set on the 
screen. You can also select fixed filter settings regardless of the screen settings. 
 
Print-outs: Desired print-out pages are selected here. Even if you have not selected a particular page for print-
out, you can always print this page later from the “Reprints” menu item. 
  
 
Print Grid: If selected, millimetric grids will also printed on the paper. Since it slows down printing and 
consumes ink. It is better to use Kardinero/Tepa ECG paper with grids already on them. 
 

Default:    This button is used to set all of the above values to default values. 
 

7.3.24.7. Lists Tab Page 
 

 
 

Figure 45. Lists Tab Page 
 
During an event capturing and recording, you can enter free text information to describe the event. For 
common event descriptions, instead of typing, you can transfer the event description from a list. You can 
create your event description list from the Lists Tab Page. You can also use the default list provided by 
StressWin Pro. (Figure 45) 
 

7.3.24.8. Info Tab Page 
 

This tab provides information about the location of files obtained as a result of an effort record. Optionally, 
files can be saved to the desired location prior to recording, or you can change them to the desired location 
after recording. (Figure 46) 
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Figure 46. Info Tab Page 
 

 

7.3.24.9. Dicom Tab Page 
 

Before this tab can be used, ‘Dicom Integration’ must be marked in the ‘General Tab’ in the ‘Setup’ section. 
Otherwise, you cannot obtain information from the Dicom tab. 

 

Dicom tab; The information in this section should be made according to the information given by the PACS 
system supervisor. Users can access the patient information and reports via the PACS network where the 
device is connected. (Figure 47) 

 

 

Figure 47. Dicom Tab Page 
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7.3.25. Averages and ST Trend Graphics 
 
On the right side of the screen, averages or ST Trend graphics are displayed. Click the right bar selection 
combo box to select your choice of Averages, ST Level or ST Slope trend graphics. If you click any of the 12 
regions displayed, that region will be enlarged four times. You can also assign any channel to any region by 
right mouse click. Averages and trends are updated on the screen in real time. (Figure 48- Figure49- Figure50) 
 
 

          
 
Figure 48. Averages      Figure 49. ST Level   Figure 50. ST Slope 
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7.3.26. Information Bar 
 

The Information Bar is shown in Figure 51. 
 

 
Figure 51. Information View 

 

total elapsed time since test started 

 

Time elapsed in the current step. On mouse click remaining time 
for the current step is displayed. 
 
total elapsed time since recovery started 

 

Percentage of the target/max heart rate achieved 
 
Target Heart Rate 
Max Heart Rate 

Blood Pressure Trend 

 

Latest Blood Pressure value 

 

total number of Ventricular ectopics encountered 

 

Name of the Protocol 

Slope and speed of treadmill 

Metabolic Equivalents of Task 
 

 

Heart rate trend 

 

Heart Rate 
 

Step name & number 
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7.3.27. Close  
 

During monitoring (i.e. before protocol steps have started), click this control to stop monitoring and go back to 
start up screen.  
 
7.3.28. Stop                    
 

This button is similar in function to emergency stop on the treadmill. When pressed treadmill will be stopped. 
Not for routine use, must only be used in emergency situations.  
 
7.3.29. Reprint 
 
All recordings and test results are saved under the data folder specified in the User Tab Page of the Setup 
window. You can use the File -> Reprints menu item to print all or selected pages of the test report.  
 

 
 

Figure 52. Report Print Page 
 
The entries you receive with the StressWin Pro program are stored in the Program Files \ Kardinero \ Data 
\.[RelatedPatientFile] .StressWin Pro program you receive the program after you exit the program as output 
from the printer. The StressWin Pro program stores the current ECG signals as a good alternative for Microsoft 
Windows 64bit resolution graphics (Portable Document Format) and JPEG (Joint Photographic Experts Group). 
The files in this format are [relatedPatientFile] \ XECG \ [year-month-day_hour-minute-second]. 
The files are saved in the “EDM_WorkSpace” file in the ‘Documents’ section of your computer. You can access 
these graphics after registration with the Acrobat Reader PDF reader under Windows, you can look and print, 
or you can still print using Windows photo’s printing wizard. When you click on the JPEG or PDF file that you 
want to print, the supported PDF reader or Windows Photo Viewer will display your chart the way you want it. 
(Figure 52)  
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8. MAINTENANCE – TROUBLESHOOTING 
 

8.1. Periodic Maintenance 
Ars-EFOR Treadmill Exercise Test System does not require detailed technical periodic maintenance. But there 
are some simple maintenance and cleaning processes that have to be done by the user. These are: 
- Visual inspection of ECG patient cable once per week in average 
- Surface cleaning of system once per week in average 
 
Cleaning of each of the system components should be followed as described below: 
 
• Treadmill 
Cleaning the belt (upper and lower surfaces) and platform once per month (according to the usage frequency, 
this process may need to be occur more frequently). Use a soft moist towel. Clean also the handles touched by 
the patients with the moist towel and apply a spray- surface disinfectant. 
• ECG Module (ECG Master USB Module) and ECG patient cable 
Clean the ECG module, carrying holder and belt and ECG cable with the soft moist towel in a gentle way 
without forcing the cables and grabbers, and apply a spray- surface disinfectant in general. 
• Main computer unit, monitor, keyboard, mouse and system trolley 
Clean all parts of the system computer and of the trolley using the soft moist towel. Use a “screen and TV 
cleaner” once a month for PC monitor. Special solutions for PC and monitor cleaning available in the market 
can be used.   
• Connection and power cables 
Clean all cables with the soft moist towel.  
• Automatic Blood Pressure Monitor (optional) 
If you also have an optional BP device, clean the BP device and BP cuff with the soft moist towel in a gentle 
way without forcing the hoses and cables. Apply a spray- surface disinfectant to the cuff. 
 

8.2. Too Much Noise in ECG Signals 
Too much noise in ECG signals is one of the problems frequently encountered in all ECG stress systems in 
general. Any of the problems mentioned below may have appeared during device usage. Thus, you must know 
the changes that have been just made before the problem has been appeared and whether a problem has 
been encountered before or not. Any device that has been connected to the same mains recently and that 
requires too much power (such as elevator, engine, air-conditioner, etc.) and any grounding related problems 
must be questioned. Principal reasons for noise in ECG signals are: 
 

1. Defective patient cable: If the cable ends or parts are corrupted, cable must be changed with a new one. 
Repairing or attempting to repair the cable by the user is not safe. Only service staff authorized by 
Kardinero can decide whether the cable may be repaired or not.  

2. System is not properly grounded; network to which the system is connected has grounding problems. The 
primary problem in the system grounding is insufficient network grounding. This must be done under the 
control of an authorized electrician. Poor quality and corrupted extending cables are one of the important 
problem sources. If necessary, outer grounding cable must be used. 

3. Using poor quality electrodes. Many of the electrode manufacturers have special electrode models 
suitable ECG for stress test. For these models, consult your product provider. 

4. Not using a bandage or something similar for fixing the electrodes: During stress ECG testing, it’s advised 
to use net bandage or similar fixing to avoid the noise caused by the movement of cable ends connected 
to the electrodes on the patient’s body and the movement of the electrodes’ adhesive surface. 

 

8.3. Image Resolution Troubleshooting 
It supports the appropriate resolution of the video card on your computer that is given to you by Kardinero. 

However, if you need to reconfigure your system for any reason, you may not be able to provide the required 
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resolution without installing the appropriate video card device driver. Please follow the steps below carefully. 

Contact an experienced computer service support or Kardinero Technical Service. 

8.4. Printer Troubleshooting 
Printer Communication Control 

If you are unable to print, there may be a communication problem with the printer. In this case, it is useful to 
check the connection cable. If you cannot solve the communication problem, contact Kardinero Technical 
Service Department.  
 
8.5. Other Problems 
 
An important majority of the problems you may encounter with your Exercise Test System are those caused by 
the noises due to the patient and network failures and by the differences in computer configuration or 
changes made in time. To have maximum efficiency of the system, you must use a well-grounded plug. One 
must be aware of the electrical parasites caused by power-consuming devices and systems nearby (for 
example elevator, X-rayed devices, air-conditioner, etc.). 

 

8.6. Descriptions of the Signs- Figures 

Descriptions of the signs used in this manual and in the device are below: 

 

 Read the User Manual carefully 
before using the device 

 Conforming EU Medical Devices 
Directory, Notified Body BSI’s 
number 2797  

 Warning: High Voltage  Defibrillator signal protected inputs 

 Manufacturer’s address   
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9. STANDARD PROTOCOL VALUES 
 

  Bruce Bruce    Modified Bruce Modified Bruce 

Steps Speed Slope Duration Speed Slope Duration  Steps Speed Slope Duration Speed Slope Duration 

  km/h % min mph % min    km/h % min mph % min 

1 2,7 10 3 1,7 10 3  1 2,7 0 3 1,7 0 3 

2 4,0 12 3 2,5 12 3  2 2,7 5 3 1,7 5 3 

3 5,5 14 3 3,4 14 3  3 2,7 10 3 1,7 10 3 

4 6,8 16 3 4,2 16 3  4 4,0 12 3 2,5 12 3 

5 8,0 18 3 5,0 18 3  5 5,5 14 3 3,4 14 3 

6 8,8 20 3 5,5 20 3  6 6,7 16 3 4,2 16 3 

7 9,7 22 3 6,0 22 3  7 8,0 18 3 5,0 18 3 

R1 2,7 0 1 1,7 0 1  8 8,8 20 3 5,5 20 3 

R2 0,0 0 1 0,0 0 1  R1 2,7 0 1 1,7 0 1 

R3 0,0 0 1 0,0 0 1  R2 0,0 0 1 0,0 0 1 

        R3 0,0 0 1 0,0 0 1 

               

  Naughton Naughton    Ellestad Ellestad 

Steps Speed Slope Duration Speed Slope Duration  Steps Speed Slope Duration Speed Slope Duration 

  km/h % min mph % min    km/h % min mph % min 

1 3,2 0,0 2 2,0 0,0 2  1 2,7 10 3 1,7 10 3 

2 3,2 3,5 2 2,0 3,5 2  2 4,8 10 2 3,0 10 2 

3 3,2 7,0 2 2,0 7,0 2  3 6,4 10 2 4,0 10 2 

4 3,2 10,5 2 2,0 10,5 2  4 8,0 10 3 5,0 10 3 

5 3,2 14,0 2 2,0 14,0 2  5 9,7 15 2 6,0 15 2 

6 3,2 17,5 2 2,0 17,5 2  6 11,3 15 2 7,0 15 2 

7 4,8 12,5 2 3,0 12,5 2  7 12,9 15 2 8,0 15 2 

8 4,8 15,0 2 3,0 15,0 2  R1 2,7 0 1 1,7 0 1 

9 4,8 17,5 2 3,0 17,5 2  R2 0,0 0 1 0,0 0 1 

R1 2,7 0 1 1,7 0 1  R3 0,0 0 1 0,0 0 1 

R2 0,0 0 1 0,0 0 1         

R3 0,0 0 1 0,0 0 1         

       
 
        

  Balke 1 Balke 1    Balke 2 Balke 2 

Steps Speed Slope Duration Speed Slope Duration  Steps Speed Slope Duration Speed Slope Duration 

  km/h % min mph % min    km/h % min mph % min 

1 5,3 2 1 3,3 2 1  1 4,8 0,0 1 3,0 0,0 1 

2 5,3 4 1 3,3 4 1  2 4,8 2,5 1 3,0 2,5 1 

3 5,3 6 1 3,3 6 1  3 4,8 5,0 1 3,0 5,0 1 

4 5,3 8 1 3,3 8 1  4 4,8 7,5 1 3,0 7,5 1 

5 5,3 10 1 3,3 10 1  5 4,8 10,0 1 3,0 10,0 1 

6 5,3 12 1 3,3 12 1  6 4,8 12,5 1 3,0 12,5 1 

7 5,3 14 1 3,3 14 1  7 4,8 15,0 1 3,0 15,0 1 

8 5,3 16 1 3,3 16 1  8 4,8 17,5 1 3,0 17,5 1 

9 5,3 18 1 3,3 18 1  9 4,8 20,0 1 3,0 20,0 1 

10 5,3 20 1 3,3 20 1  10 4,8 22,5 1 3,0 22,5 1 

               

11 5,3 22 1 3,3 22 1  R1 2,7 0 1 1,7 0 1 

12 5,3 24 1 3,3 24 1  R2 0,0 0 1 0,0 0 1 

13 5,3 26 1 3,3 26 1  R3 0,0 0 1 0,0 0 1 

R1 2,7 0 1 1,7 0 1         

R2 0,0 0 1 0,0 0 1         

R3 0,0 0 1 0,0 0 1         
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  Mc Henry Mc Henry    ACIP ACIP 

Steps Speed Slope Duration Speed Slope Duration  Steps Speed Slope Duration Speed Slope Duration 

  km/h % min mph % min    km/h % min mph % min 

1 3,2 3,0 3 2,0 3,0 3  1 3,2 0,0 3 2,0 0,0 3 

2 5,3 6,0 3 3,3 6,0 3  2 4,0 2,0 3 2,5 2,0 3 

3 5,3 9,0 3 3,3 9,0 3  3 4,8 3,0 3 3,0 3,0 3 

4 5,3 12,0 3 3,3 12,0 3  4 4,8 7,0 3 3,0 7,0 3 

5 5,3 15,0 3 3,3 15,0 3  5 4,8 10,5 3 3,0 10,5 3 

6 5,3 18,0 3 3,3 18,0 3  6 4,8 14,0 3 3,0 14,0 3 

7 5,3 21,0 3 3,3 21,0 3  7 4,8 17,5 3 3,0 17,5 3 

R1 2,7 0 1 1,7 0 1  8 4,8 21,0 3 3,0 21,0 3 

R2 0,0 0 1 0,0 0 1  9 5,0 24,0 3 3,1 24,0 3 

R3 0,0 0 1 0,0 0 1  10 5,5 24,0 3 3,4 24,0 3 

        R1 2,7 0 1 1,7 0 1 

        R2 0,0 0 1 0,0 0 1 

        R3 0,0 0 1 0,0 0 1 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

  Ergo 

Steps watt Duration 

  Kpm/min min 

1 25 1 

2 49 1 

3 74 1 

4 98 1 

5 123 1 

6 148 1 

7 172 1 

8 197 1 

9 221 1 

10 246 1 

R1 25 1 

R2 0 1 

R3 0 1 

   Persantine 

 Steps Speed Slope Duration 

   mph % min 

 1 0 0 1 

 2 0 0 1 

 3 0 0 1 

 4 0 0 1 

 R1 0 0 2 

 R2 0 0 1 

 R3 0 0 1 

 R4 0 0 1 

 R5 0 0 1 

 R6 0 0 1 
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Annex: A 
SOFTWARE LICENSE AGREEMENT- SINGLE USER 

 

IMPORTANT: PLEASE READ CAREFULLY BEFORE COPYING, INSTALLING or USING 

Do not use or load this software and any associated materials (collectively, the "Software") until you have 
carefully read the following terms and conditions. By loading or using the Software, you agree to the terms of 
this Agreement. If you do not wish to so agree, please do not install or use the Software. 
 
LICENSE. You may copy the Software onto a single computer, where also necessary ECG hardware is connected 
as described in their manuals, for your personal use, and you may make one back-up copy of the Software, 
subject to these conditions:  
1. You may not copy, modify, rent, sell, distribute or transfer any part of the Software except as provided in this 
Agreement, and you agree to prevent unauthorized copying of the Software. 
2. You may not reverse engineer, decompile, or disassemble the Software.  
3. You may not sublicense or permit simultaneous use of the Software by more than one user. 
4. The Software may include portions offered on terms in addition to those set out here, as set out in a license 
accompanying those portions.  
 
OWNERSHIP OF SOFTWARE AND COPYRIGHTS. Title to all copies of the Software remains with Kardinero/Tepa 
or its suppliers, distributors or sub-dealers. The Software is copyrighted and protected by the laws of Turkey 
and other countries and international treaty provisions.  
You may not remove any copyright notices from the Software. Kardinero may make changes to the Software, 
or to items referenced therein, at any time without notice, but is not obligated to support or update the 
Software. Except as otherwise expressly provided, Kardinero grants no expressed or implied right under 
Kardiosis/ Kardinero patents, copyrights, trademarks, or other intellectual property rights. You may transfer 
the Software together with the hardware only if the recipient agrees to be fully bound by these terms and if 
you retain no copies of the Software.  
 
LIMITED MEDIA WARRANTY.  If the Software has been delivered by Kardinero on physical media, Kardinero 
warrants the media to be free from material physical defects for a period of ninety days after delivery by 
Kardinero. If such a defect is found, return the media to Kardinero for replacement or alternate delivery of the 
Software as Kardinero may select. 
 
Exclusion of other warranties. Except as provided above, the software is provided "as is" without any express or 
implied warranty of any kind including warranties of merchantability, non-infringement, or fitness for a 
particular purpose.   
 
Termination of this agreement. Kardinero may terminate this agreement at any time if you violate its terms. 
Upon termination, you will immediately return the hardware and all copies of the software to Kardinero. 
  
Applicable laws. Claims arising under this agreement shall be governed by the laws of Turkey, excluding its 
principles of conflict of laws and the United Nations convention on contracts for the sale of goods. You may not 
export the software in violation of applicable export laws and regulations. Kardinero is not obligated under any 
other agreements unless they are in writing and signed by an authorized representative of Kardinero. 
Contractor or manufacturer is Kardinero, ODTU Teknokent Gümüs Blok BK-7/B Ankara, 06800- Turkey 
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Annex: B 
LIMITED INTERNATIONAL WARRANTY  

(Please ask your local dealer for details) 
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Annex: C 
EMC (Electromagnetic Compatibility) Declaration: 

This device has been tested according to the standard IEC60601-1-2: 2016 Electromagnetic Compatibility for Medical 
Devices and verified that the measured values are within the specified limits. This device generates and uses radio 
frequencies and its energy, and if not used according to the instructions given in this manual, it may cause undesired 
effects on some other devices in the vicinity. If it is realized that this device affects other devices in the vicinity, following 
measures should be taken: 

- Change the place of the device, 
- Increase the distance between the devices, 
- Connect the device to another power socket, 
- Ask the manufacturer for support. 

Mobile communication devices, wireless phones may affect this device’s normal operation. 

Using cables and accessories which are not recommended in this manual, may cause improper results. 

Tests applied to this device are summarized below:  
EMC (Electromagnetic Compatibility)- Electromagnetic Immunity Declaration- and Guidance for Professional Healthcare 
Facility Environment: 
Kardinero Ars-Efor ECG Stress Test System is intended for use in a Professional Healthcare Facility within the 
electromagnetic environment specified below. It is not intended for home use. It is not designed for use together with HF 
surgical equipment. This equipment has been tested and found to comply with the limits for medical devices to IEC 
60601-1-2. 
 

Emission Tests Application/ Compliance  Electromagnetic environment- guide 

Radiated RF emissions EN 
55011 (CISPR 11) 
Class B  

ECG Module and Treadmill. 
30- 1000 MHz. 3 m antenna; both 
V/H polarization.  
 
Passed the test. Complies. 

The device may radiate high frequency 
electromagnetic waves in the environment because of 
the active electronic components- circuits. But the 
levels of such signals are very low and within the limits 
defined in the relevant standards.  

Conducted emissions EN 
55011 (CISPR 11) 
Class B 

NA for ECG Module; treadmill 
power only. 
0.15- 30 MHz  
 
Passed the test. Complies. 

Kardinero PC based ECG and stress test system with 
treadmill is suitable to use in in all establishments 
including those directly connected to the public low-
voltage power supply network.  

Voltage variations and 
flicker emissions EN 
61000-3-3 and  
Harmonic emissions 
61000-3-2 

NA for ECG Module; treadmill 
power only. 
Short term flicker 1.00 
Long term flicker 0.65 
Max. time 500 ms RSSV Change 
3.30%; dmax 4% 
And harmonics measurement 
 
Passed the test. Complies. 

Kardinero PC based ECG and stress test system with 
treadmill is suitable to use in in all establishments 
including those directly connected to the public low-
voltage power supply network. 

 

Immunity Tests 
 

Applied to 
 

Test parameters and 
compliance 

Electromagnetic environment- guide 

Electrostatic 
discharge (ESD) 
EN 61000-4-2 

ECG Module and Treadmill; all 
inputs and insulating surfaces 

Contact: 8 kV 
Air: 2, 4, 8, 15 kV 
Horizontal and vertical 
coupling planes 8 kV 
Disch. Imp.: 330 Ohm/ 150 
pF 
10 positive/ 10 negative 
discharges 
 
Passed the test. Complies. 

Electrostatic discharges caused by any 
furniture, floor material, static electricity 
producing cloths etc may affect the 
quality of the signals acquired during the 
use of the device and may be harmful 
for the device. The device complies 
relevant standards in this respect. Floors 
of the room should be antistatic. The 
users and patients should avoid wearing 
static electricity producing material.  

Radiated RF EM 
fields EN 61000-
4-3 

ECG Module and Treadmill 
enclosures 

80 MHz to 2700MHz 
3V/m – Antenna distance 3 
m 
80% AM at 1kHz sin 

Such electromagnetic fields should be at 
low levels in a typical commercial or 
hospital environment. Wireless 
communication equipment during their 
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Passed the test. Complies. 

use should be kept out of the room of 
the system. 

Electrical fast 
transient 
immunity/ burst 
EN 61000-4-4 

ECG Module to com port N/A; 
Applied to Treadmill to power 
line input 

Treadmill: 2 kV, 100 kHz, ≥ 
60 s 
 
Passed the test. Complies. 

Mains power quality should be that of a 
typical commercial or hospital 
environment- professional healthcare 
facility. 

Surge immunity 
EN 61000-4-5 

ECG Module N/A; Treadmill to 
power line input and 
protective gnd. 

0.5 and 1 kV line- line; 2 kV 
line- gnd. o/p impedance:  2 
ohm and 12 Ohm 
respectively; phase 0°, 90°, 
180°, 270° 
 
Passed the test. Complies. 

Mains power quality should be that of a 
typical commercial or hospital 
environment- professional healthcare 
facility. 

Immunity to 
conducted 
Disturbances 
induced by RF 
fields IEC 
61000-4-6 

ECG Module N/A; Treadmill to 
power inputs 

Field 3 V; 0.15 MHz- 80 
MHz; 
AM 80%- 1 kHz sine; 1 % 
steps w. 2 s dwell 
 
Passed the test. Complies. 

Mains power quality should be that of a 
typical commercial or hospital 
environment- professional healthcare 
facility. 

Immunity to 
Power 
Frequency 
(50Hz) magnetic 
field IEC 61000-
4-8 

Treadmill and ECG Module 
enclosure 

30 A/m; 50- 60 Hz 
 
Passed the test. Complies. 

As the device makes sensitive 
measurements, it is not recommended 
to use this device in the vicinity of 
disturbing equipment. The device is not 
affected from the disturbances within 
the normal limits radiated from such 
sources (like transformers, motors etc). 
Such magnetic fields should be at known 
levels in a typical location of a hospital 
environment. 

Voltage dips, 
short 
interruptions 
and voltage 
variations on 
power supply 
input lines IEC 
61000-4-11 

ECG Module N/A; Treadmill to 
power line input 

Minimum 3 test events 
10 s (min) 
0°, 45°, 90°, 135°, 180°, 
225°, 270°, 315°, 
 
3 Test cycles 
Passed the test. Complies. 

Mains power quality should be that of a 
typical commercial or hospital 
environment- professional healthcare 
facility. If the users need it during power 
mains interruption, it is recommended 
that the system is powered from an 
uninterruptible power supply (UPS). 
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